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1. TEMPLATE FILE SPECIFICATION 

Template files contain details of an imposition layout (pages, marks, tiles, etc.). A template 
file is created by Preps whenever the template design window has focus, and the user invokes 
the File > Save or File > Save As menu option. Template files always reside in the 
Template directory (below the Preps code file directory), and the filename suffix is always 
.TPL. 

1.1 Template File Structure 

Each template file is comprised of the following tags, in the order shown: 

Table 1  Template File Tags 

Tag Name Occurrences per File 

%!PS One 

%%Creator One 

%SsiPrepsVer One 

%SsiLayout One 

The next two lines establish defaults for the template: 

%SsiPressSheet One to establish defaults 

%SsiPrshPage One to establish defaults 

 The remaining lines are repeated for each signature in the template. 

%SsiSignature One for each signature in the template design 

%SsiPressSheet One for each press sheet (web) in the current signature 

%SsiPrshMark One for each sheet mark on the current press sheet 

%SsiTileGroup One for each media size that has “custom tiling” defined for the press 
sheet that this tag applies to. 

%SsiTileBreak One for each custom tile for the current device 

This group of tags defines an imposition including pages on the current press sheet: 

%SsiPrshMatrix Imposition geometry (gutter & page dimensions) 

%SsiPrshPage One for each imposed page on the current press sheet 

%SsiPrshMark One for each crop mark for current page 

%SsiMatrix End of imposition geometry 

This group of tags is repeated for each independent page on the current press sheet: 

%SsiPrshPage One for each independent page on the current press sheet 

%SsiPrshMark One for each crop mark for current page 

Note: A press sheet can have either imposed or independent pages, or both. Imposed pages 
are those having the same size and laid out in a uniform matrix, for example a 4x2 array of 
6x9" pages for a book. Independent pages are those with any size and laid out in an arbitrary 
pattern, as for gang-up work. 

The hierarchy of the various objects associated with templates is indicated by indentation 
levels in the following table: 
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Table 2  Hierarchy of Template Objects 

Object Type Associated Tag 

Template  

Creator (1)  %SSiCreator: 

 Spec version (1)  %SSiPrepsVer: 

Layout (1) %SSiLayout: 

Default press sheet spec (1)  %SSiPressSheet: 

Default page spec (1)  %SSiPrshPage: 

Signatures (1 or more)  %SSiSignature: 

Press sheets (1 or more)  %SSiPressSheet: 

Sheet marks (0 or more)  %SSiPrshMark: 

Imposed page arrays (0 or more)  

Page count (1)  %SSiPrshMatrix: 1 

Page width & height (1)  %SSiPrshMatrix: 8/9 

Fold mark width & length (1)  %SSiPrshMatrix: 10/11 

Page orientations (1)  %SSiPrshMatrix: 12 

Matrix layout (horiz & vert)  %SSiPrshMatrix: 13/14 

Gutter & page sizes (N)  %SSiPrshMatrix: 4/5 

Pages (1 or more)  %SSiPrshPage: 

Crop marks (0 or more)  %SSiPrshMark: 

End of imposition marker (1)  %SSiPrshMatrix: 7 

Independent pages (0 or more) %SSiPrshPage: 

Crop marks (0 or more)  %SSiPrshMark: 

 

1.2 Template File Tag Specifications 

This section describes the tags and their parameters in the order outlined in Table 1. 

1.2.1 %%Creator: 

%%Creator: <Creator> 

This tag identifies the file’s creator, for example, Preps 3.0a Windows. 
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1.2.2 %SSiPrepsVer: 

%SSiPrepsVer: <Version> 

This tag provides the version of this specification that was used when creating the file.  

For Preps 4.x and earlier, this value is 1.  

For Preps 5.x and later, this value is 2. 

1.2.3 %SSiLayout: 

%SSiLayout: <Name> <Filename> <FullSig> <PartPos> <PageH> <PageW> <Flags> 

This tag provides basic template information that applies to all signatures. 

<Name> Text string that provides the name assigned to the template by the Preps user, for 
example, Tutorial-16 Page. 

<Filename> Previous to 4.1, this was a text string that provides the path and file name for the 
current template file, for example, c:\scenic\template\tutor_16.tpl. 

In Preps 4.1 and later, this field is ignored by Preps, which now derives this 
information from the external file name. When Preps 4.1 writes this field out it is 
identical to the <Name> field. 

<FullSig> This parameter no longer used. 

<PartPos> Integer indicating where partial signatures are to be located when flowing a job 
through the template in autoselect mode; for example, 1 means one signature 
from the back of the signature list. 

<PageH> Dimension that provides the default page width for the template. Not used. 

<PageW> Dimension that provides the default page height for the template. Not used. 

<Flags> Integer that encodes the following options: 

One of the first five options is selected to specify the template’s binding style: 

FLATWORK = $0000 

PERFECTBOUND = $0001 

SADDLESTITCH = $0002 

COME-N-GO = $0003 

CUT-N-STACK = $0004 

The other two options specify bit flags that are bitwise or’d with the binding style to 
represent each option if true. 

The first flag indicates that partial signatures are placed relative to the last of the 
job’s signatures rather than to the first (see <PartPos>). 
LAYOUT_FLAGS_PART_BACK = $0008 

The second flag indicates that this template has multiple deliveries specified in it. 
LAYOUT_FLAGS_HAS_MULTIPLE_DELIVERY = $0010 
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1.2.4 %SSiSignature: 

%SSiSignature: <Name> <PageCount> <Flags> <Webs> <DeliveryCount> 

This tag provides the basic parameters applicable to one of the template’s signature layouts. 

<Name> Text string that provides the name assigned to the signature template by the 
Preps user, for example Tutorial-16 Page. Note: A Preps template can 
contain layouts for more than one signature. 

<PageCount> Integer number that provides the number of pages in the signature layout. For 
example, with a 2x4-up imposition, the value is "8". 

Technically, the value is calculated as the highest page number minus the lowest page 
number plus 1. For multiple delivery signatures, each delivery is calculated this way, and 
then they are all added together. 

<Flags> Integer number coded to control how a signature is used: 

SIG_FLAGS_LOCKED = $0001;   { Do not allow editing. } 

SIG_FLAGS_AUTOUSE = $0002;  { Use in automatic layout. } 

SIG_FLAGS_AUTONBR = $0004;  { Automatically count pages. }  

The AUTOUSE option allows the signature to be used when the Preps 
AutoSelect feature is being used to flow a job through a template. These options 
can be combined by adding the hexadecimal values shown. The LOCKED and 
AUTONBR options are not honored or implemented at this time. 

<Webs> Integer number that provides the number of press sheets or webs in the 
signature. 

<DeliveryCount> Integer that represents the number of deliveries in this signature. 

 

1.2.5 %SSiPressSheet: 

%SSiPressSheet: <Width> <Height> <PunchX> <PunchY> <Style> <GuideDist> 
<Flags> <CtrMarkLen> <SmartCount> 

This tag provides the basic parameters associated with one press sheet in the current template 
signature. 

<Width> Dimension that provides the width of the press sheet. 

<Height> Dimension that provides the height of the press sheet. 

<PunchX> This parameter is no longer used. Punch coordinates are always centered 
horizontally on the sheet. 

<PunchY> Dimension that provides the punch mark’s vertical location relative to the sheet’s 
bottom edge. 
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<Style> Integer number that provides the workstyle of the signature, coded as follows: 

SHEETWISE  =  0 

WORKNTURN  =  1 

WORKNTUMBLE  =  2 

SINGLE_SIDED  =  3 

PERFECTOR  =  4 

These options are mutually exclusive. 

<GuideDist> Dimension that provides the distance of the side guide marks from the edge of 
the sheet identified by the next parameter. 

<Flags> Integer number that provides the sheet edge from which the side guide location 
is measured, encoded as follows: 

PRSH_GUIDE_LEFT  =  0 

PRSH_GUIDE_BOTTOM  =  1 

PRSH_GUIDE_RIGHT  =  2 

PRSH_GUIDE_TOP  =  3 

PRSH_GUIDE_NONE  =  4 

PRSH_GUIDE_MASK  =  7 

PRSH_FLAGS_DEFAULT  =  PRSH_GUIDE_BOTTOM 

These options are mutually exclusive. 

<CtrMarkLen> Dimension that provides the length of the center mark printed on each press 
sheet. 

<SmartCount> Integer that represents the number of SmartMarks defined in this press sheet. 
This number of SmartMark definitions (see Chapter 2, page 16) immediately 
follow this line in the file. 

 

1.2.6 %SSiTileGroup: 

%SSiTileGroup: <TileW> <TileH> <GroupX> <GroupY> <GroupFlags> 

A template can contain tiling layouts for more than one media size. This tag specifies one 
such tiling layout. Individual tiles in the layout are specified by the %SSiTileBreak tag. 

<TileW> Dimension that provides the width of each tile (i.e. the media width). 

<TileH> Dimension that provides the height of each tile (i.e. the media height). 

<GroupX> Integer that provides the maximum number of tiles horizontally needed to tile an 
entire press sheet. 

<GroupY> Integer that provides the maximum number of tiles vertically needed to tile an 
entire press sheet. 
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<GroupFlags> Integer that controls various tile options, encoded as follows: 

TILEGROUP_VARIABLE_LEN  =  $0001 

TILEGROUP_MAJOR_HORIZ  =  $0002 

TILEGROUP_MIRROR_BACK  =  $0004 

TILEGROUP_HAS_PUNCH  =  $0008 

TILEGROUP_FINALGROUP  =  $0010 

TILEGROUP_FLAGS_DEFAULT  =  $0000 

These options can be combined by adding the hexadecimal values shown. 

  

 Note: With variable-length roll-fed devices, either <TileW> or <TileH> will define the 
maximum variable dimension supported by the device. 
 

1.2.7 %SSiTileBreak: 

%SSiTileBreak: <PosRX> <PosRY> <Width> <Orientation> <XNo> <YNo> <Flags> 
<ImageLLRX> <ImageLLRY> <SizeRDX> <SizeRDY> 

This tag defines a single tile associated with the current tile group (see %SSiTileGroup:). 

<PosRX> Dimension that specifies the horizontal position of the lower left corner of the tile. 

<PosRY> Dimension that specifies the vertical position of the lower left corner of the tile. 

<Width> Dimension that provides the actual width of the tile. This is only used with 
variable-length roll-fed devices. 

<Orientation> Integer number that provides the orientation of the tile, encoded as follows: 

ORIENTATION_LEFT  =  0 

ORIENTATION_DOWN  =  1 

ORIENTATION_RIGHT  =  2 

ORIENTATION_UP  =  3 

Tiles can have any of the four orientations when associated with a punch device. 

<XNo> Integer that provides the horizontal index for the tile. The leftmost tile has an 
index of 1. 

<YNo> Integer that provides the vertical index for the tile. The uppermost tile has an 
index of 1. 
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<Flags> Integer parameter that encodes the following tile options: 

HARD_EDGE  =  0 

FILM_JOINT  =  1 

OPEN  =  2 

The FILM_JOINT option is used with certain capstan devices where two tiles are 
mounted side-by-side, with their adjacent edges abutting. 

<ImageLLRX> Dimension that specifies the horizontal position of the lower left corner of the 
lower left page on the tile, relative to the lower left corner of the tile. 

<ImageLLRY> Dimension that specifies the vertical position of the lower left corner of the lower 
left page on the tile, relative to the lower left corner of the tile. 

<SizeRDX> Dimension that provides the cumulative width of the pages and gutters 
appearing on the tile. 

<SizeRDY> Dimension that provides the cumulative height of the pages and gutters 
appearing on the tile. 

 

1.2.8 %SSiPrshMark: 

%SSiPrshMark: <PointRX> <PointRY> <ExtentRDX> <ExtentRDY> <Type> <Size>  

<Name> <Rotation> <ColorType> <Color1> <Color2> <Color3> <Color4> 

<DupFlags> <SigMod> <SigStart> <Delivery> <SmartIndex> <RParam1> <RParam2> 

This tag specifies the type, location, and other parameters of a mark. Marks can be associated 
with either the current press sheet or with the current page. Mark locations are specified 
relative to the associated object’s 0, 0 origin, except in the case of page crop marks, which 
are positioned relative to a specific page corner. 

<PointRX> Real number that provides the horizontal position of the mark’s lower-left 
corner. 

<PointRY> Real number that provides the vertical position of the mark’s lower-left corner. 

<ExtentRDX> Real number that provides the mark’s width. 

<ExtentRDY> Real number that provides the mark’s height. 

<Type> Integer number that describes the mark type, encoded as one of the following: 

MARKTYPE_LINE  =      $0000 

MARKTYPE_SHADEDRECT  =  $0001 

MARKTYPE_SIGSLUG  =     $0002 

MARKTYPE_STRING  =      $0003 

MARKTYPE_LLCROP  =      $0004 

MARKTYPE_LRCROP  =      $0005 

MARKTYPE_URCROP  =      $0006 



PREPS 5.1 PAGE 8 

PREPS TEAM 14 OCTOBER 2004 TEMPLATE FILE SPECIFICATION  

MARKTYPE_ULCROP  =      $0007 

MARKTYPE_HORIZTILE  =   $0008 

MARKTYPE_VERTTILE  =    $0009 

MARKTYPE_DOTLINE  =     $000A 

MARKTYPE_DASHLINE  =    $000B 

MARKTYPE_SIGSLUG1  =    $0010 

MARKTYPE_SIGSLUG2  =    $0011 

MARKTYPE_FLATIDSTRING =  $0012 

MARKTYPE_UNKNOWN  =     $0013 

MARKTYPE_RLEXPOSURE  =  $0014 

MARKTYPE_TDEXPOSURE  =  $0015 

MARKTYPE_LREXPOSURE  =  $0016 

MARKTYPE_BUEXPOSURE  =  $0017 

MARKTYPE_LAST  =      $0018 

MARKTYPE_USERCUSTOM  = $4000 (see <Name> parameter)  

MARKTYPE_USERSTEPPER  = $4001 (see <Name> parameter)  

<Size> Dimension that provides the step distance for collation marks. This parameter 
is not used with other mark types. 

<Name> Text string that provides the file name for an external mark (type USERCUSTOM 
or USERSTEPPER) or the text string to be printed in a text mark. 

<Rotation> Specifies mark rotation around the lower left corner of the mark position.  Only 
90 degree increments are currently supported for text marks.  For line marks, 
arbitrary rotation is supported. 

<ColorType> Integer number that specifies the color separations on which the mark will 
appear, encoded as follows: 

BLK  =  $0000 {all separations} 

SPOT  =  $0001 {use custom mark color}  

PROCESS  =  $0002 {use custom mark process color build} 

These options correspond to the radio button choices in the Preps Template 
Mark Color dialog box. 

<ColorN> The function of these four integer parameters (<Color1> through <Color4>) 
depend on which <ColorType> has been selected.  

With a <ColorType> of BLK, <Color1> specifies the screen density of the mark 
in percent, and the remaining three parameters are not used.  

With a <ColorType> of SPOT, <Color1> specifies the screen density of the 
mark in percent, <Color2> specifies the SSiCustomColor number, and the 
remaining two parameters are not used.  
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With a <ColorType> of PROCESS, the four parameters provide the cyan, 
magenta, yellow and black screen densities respectively. 

<DupFlags> Integer number that controls when and how a mark appears on a press sheet, 
encoded as follows: 

DUP_FRONT = $0001 {Mark is shown on front of Press Sheet} 

DUP_BACK = $0002 {Mark is shown on back of Press Sheet} 

CENTERED = $0004 {Show user center of mark in dialog only} 

UNMIRROREDPOS = $0008 {This mark does not mirror position 
front to back} 

MIRROR_IMAGE = $0010 {Mark does mirror front to back} 

BRING_TO_FRONT = $0020 {Mark will image over page imagery} 

DUP_DEFAULT = PRSHMARK_DUP_FRONT + PRSHMARK_DUP_BACK 

The FRONT and BACK options cause the mark to be printed on the front and 
back of the press sheet, respectively.  

The CENTERED option centers the mark on the point defined by the 
<PointRX> and <PointRY> parameters (corresponding to the Center Mark on 
Point check box in the Preps Template Mark Information dialog box).  

The UNMIRRORED option is not supported at this time.  

These options can be combined by adding the values shown. 

<SigMod> Integer field that specifies which signatures the mark is printed on. For 
example, 3 specifies that the mark is to be printed on every third signature. 

<SigStart> Integer field that specifies the first signature number the mark is printed on. 

<Delivery> Integer that indicates which delivery this mark will be printed on. 1 represents 
the first delivery. 

<SmartIndex> Always zero. PrshMarks generated by SmartMarks are not read from or written 
to template files. 

<RParamN> The real parameters <RParam1> and <RParam2> are reserved for future use. 

 

1.2.9 %SSiPrshMatrix: 

%SSiPrshMatrix: <Type> <IMargin1> <IMargin4> <Flags> 

This tag is used for a variety of often unrelated purposes, depending on the value of the 
<Type> parameter. 

<Type> Integer field that specifies the purpose of the tag and how it is to be interpreted. 

COUNT  =  1 {Total pages in an imposition} 

HORIZ  =  2 {Start horiz imposition dimensions} 

VERT  =  3 {Start vert imposition dimensions} 
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MARGIN  =  4 {Specify a margin or gutter width} 

OBJECT  =  5 {Specify a page width} 

END  =  7 {Mark the end of an imposition spec} 

PGWIDTH  =  8 {Specify page width in imposition} 

PGHEIGHT  =  9 {Specify page height in imposition} 

FOLDWID  =  10 {Specify fold mark width} 

FOLDLEN  =  11 {Specify fold mark length} 

ORIENTS  =  12 {Specify page orientations} 

CENTERVERT  =  13 {Start vert imposition dimensions} 

CENTERHORIZ  =  14 {Start horiz imposition dimensions} 

<IMargin1> The use of this real parameter depends on the <Type> parameter value (see 
the  %SSiPrshMatrix: <Type> Descriptions subsection).. 

<IMargin4> The use of this real parameter depends on the <Type> parameter value (see 
the  %SSiPrshMatrix: <Type> Descriptions subsection). Unless 
otherwise stated, <IMargin4> is always 0.  

<Flags> The use of this integer parameter depends on the <Type> parameter value 
(see the  %SSiPrshMatrix: <Type> Descriptions subsection). The 
parameter is encoded as follows: 

HORIZ  = 0 

VERT  = 1 

FOLDOFF  = 2 

DEFAULT  = 0 

Unless otherwise stated, this parameter always has a value of 1. 

Note: The VERT and HORIZ options are similar to the CENTERVERT and CENTERHORIZ options 
respectively, except that the first pair is used when an imposition is not centered on the sheet, 
and the second pair is used when an imposition is centered on the sheet.  
 

1.2.9.1  %SSiPrshMatrix: <Type> Descriptions 

The following sections explain the use of the %SSiPrshMatrix tag with different <Type> 
parameter values. 

%SsiPrshMatrix: 1 <IMargin1> provides the total number of pages in the current imposition. 

%SsiPrshMatrix: 2 Indicates the start of that specifies the margin/gutter and page widths 
across an imposition. Thus, for a 4x2 array of pages, there will be a 
sequence of %SSiPrshMatrix commands with the following type: 14, 
4, 5, 4, 5, 4, 5, 4, 5, 4. This tag is used only when the imposition is not 
centered on the press sheet. 

%SsiPrshMatrix: 3 Indicates the start the series of %SSiPrshMatrix commands that 
specify the margin/gutter and page widths across an imposition. Thus, for 
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a 4x2 array of pages, there will be a sequence of %SSiPrshMatrix 
commands with the following types: 13, 4, 5, 4, 5, 4. This tag is used 
only when the imposition is not centered on the press sheet. 

%SSiPrshMatrix: 4 <IMargin1> and <IMargin4> provide the widths of either of the following: 

a) A margin between the imposition and the adjacent sheet edge.  

 When specifying the left or top margin, put the margin width in 
<IMargin1>. 

 When specifying the right or bottom margin, put the margin width 
in <IMargin4>. 

b) The two halves of a gutter between the two adjacent pages in the 
imposition.  

 <IMargin1> provides the left- or top-most half. 

 <IMargin4> the right- or bottom-most half. 

%SSiPrshMatrix: 5 <IMargin5> provides the width of one page in the imposition. 

%SSiPrshMatrix: 6 [Not used] 

%SSiPrshMatrix: 7 Indicates the end of the current imposition specification. <IMargin1> is 
set to -1. 

%SSiPrshMatrix: 8 <IMargin1> provides the width of a page in the current imposition. 

%SSiPrshMatrix: 9 <IMargin1> provides the height of a page in the current imposition. 

%SSiPrshMatrix: 10 <IMargin1> specifies the fold mark width. 

%SSiPrshMatrix: 11 <IMargin1> specifies the fold mark length. 

%SSiPrshMatrix: 12 <IMargin1> specifies how imposition pages are oriented. For example, a 
value of 7 indicates that the lower left page is head-up, and adjacent 
rows of pages are head-to-head or foot-to-foot. 

%SSiPrshMatrix: 13 Identicial to %SSiPrshMatrix: 3, except it is used when the imposition is 
centered on the press sheet. 

%SSiPrshMatrix: 14 Identicial to %SSiPrshMatrix: 2, except it is used when the imposition is 
centered on the press sheet. 

 

1.2.10 % SSiPrshPage: 

%SSiPrshPage: <PointRX> <PointRY> <ExtentRDX> <ExtentRDY> <Orientation> 
<Front> <Back> <BleedLLX> <BleedLLY> <BleedURX> <BleedURY> <ShingledIR> 
<ShingleAmt> <Scaling> <Angle> <BottleAbout> <BottleArbX> <BottleArbY> 
<Delivery> 
 

<PointRX> Real number that provides the horizontal location of the page’s lower left 
corner, relative to the sheet’s 0, 0 origin. 

<PointRY> Real number that provides the vertical location of the page’s lower left corner, 
relative to the sheet’s 0, 0 origin. 
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<ExtentRDX> Real number that provides the width of the page. 

<ExtentRDY> Real number that provides the height of the page. 

<Orientation> Integer number indicating the orientation of the page, encoded as follows: 

ORIENTATION_LEFT  =  0 

ORIENTATION_DOWN  =  1 

ORIENTATION_RIGHT  =  2 

ORIENTATION_UP  =  3 

ORIENTATION_MASK  =  3 

ORIENTATION_DEFAULT =  ORIENTATION_UP 

ORIENTATION_IMPOSE  = 4 {bit to indicate part of an imposition} 

<Front> Integer number that provides the page number on the front of the sheet. 
Note: This is the page number in the template, not the number of a job page. 

<Back> Integer number that provides the page number on the back of the sheet. 
Note: This is the page number in the template, not the number of a job page. 

<BleedLLX> Real number that provides the custom bleed width at the page’s left edge. 

<BleedLLY> Real number that provides the custom bleed width at the page’s bottom edge. 

<BleedURX> Real number that provides the custom bleed width at the page’s right edge. 

<BleedURY> Real number that provides the custom bleed width at the page’s top edge. 

<ShingledIR> Integer number that provides the shingling direction, encoded as follows: 

SHINGLE_LEFT = 0 

SHINGLE_DOWN = 1 

SHINGLE_RIGHT = 2 

SHINGLE_UP = 3 

SHINGLE_BINDING = 4 

SHINGLE_FACE = 5 

SHINGLE_MASK = $000F 

SHINGLE_DEFBLEED = $2000 

SHINGLE_AUTO = $4000 

SHINGLE_DEFAULT = SHINGLE_BINDING + SHINGLE_AUTO + 
SHINGLE_DEFBL 

<ShingleAmt> Real number that provides the shingling amount for the current page. 

<Scaling> This parameter is no longer used. Page scaling factors are now controlled by 
the job file. 

<Angle> Real number indicating the page rotation in degrees, as used for bottling 
compensation. Positive numbers rotate pages counterclockwise (when viewed 
from the front of the sheet). 
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<BottleAbout> Integer number indicating the center of rotation when the page is rotated 
through the angle provided by <Angle>, encoded as follows: 

BOTTLE_CENTER  =  0 

BOTTLE_LL  =  1 

BOTTLE_LR  =  2 

BOTTLE_UL  =  3 

BOTTLE_UR  =  4 

BOTTLE_ARB  =  5 

<BottleArbX> Real number that provides the horizontal location of the center of rotation, 
relative to the page’s 0, 0 origin. Only used when <BottleAbout> = 5. 

<BottleArbY> Real number that provides the vertical location of the center of rotation, relative 
to the page’s 0, 0 origin. Only used when <BottleAbout> = 5. 

< Delivery > Integer that indicates the delivery that this press sheet page is ON. The value 1 
will represent the first delivery. This parameter is optional. For completeness it 
should always be excluded and set to 1 by default. 

1.3 Sample Template File 
%!PS 

% This: Template File: c:\scenic\template\tutor_16.tpl 

%%Comment: Preps 3.0b for Windows 

%SSiPrepsVer: 1 

%SSiLayout: |Tutorial-16 Page| |c:\scenic\template\tutor_16.tpl| 1 1 792.0000 

612.0000 9 

%SSiPressSheet: 2736.0000 1800.0000 0.0000 72.0000 0 324.0000 1 18.0000 

%SSiPrshPage: 0.0000 0.0000 0.0000 0.0000 3 1 1 0.0000 0.0000 0.0000 0.0000 

24580 0.0000 1.0000 0.0000 1 0.0000 0.0000 

%SSiSignature: |16 Page| 16 6 1 

%SSiPressSheet: 2736.0000 1800.0000 0.0000 72.0000 0 324.0000 1 18.0000 

%SSiPrshMark: 720.0000 882.0000 576.0000 27.0000 2 27.0000 |Sig: $sig Side: 

$side $color| 0.0000 0 60 60 100 100 1 1 1 0 0 0.0000 0.0000 

%SSiPrshMark: 0.0000 -72.0000 432.0000 25.7040 18 0.0000 |$comment| 0.0000 0 

100 100 100 100 11 1 1 0 0 0.0000 0.0000 

%SSiPrshMark: 2376.0000 -72.0000 360.0000 25.7040 18 0.0000 |Sig: $sig-$side 

$color| 0.0000 0 100 100 100 100 11 1 1 0 0 0.0000 0.0000 

%SSiPrshMatrix: 1 8.0000 0.0000 1 

%SSiPrshMatrix: 8 612.0000 0.0000 1 

%SSiPrshMatrix: 9 792.0000 0.0000 1 

%SSiPrshMatrix: 11 36.0000 0.0000 1 

%SSiPrshMatrix: 10 0.0000 0.0000 1 
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%SSiPrshMatrix: 12 7.0000 0.0000 1 

%SSiPrshMatrix: 2 58.5000 0.0000 1 

%SSiPrshMatrix: 4 0.0000 0.0000 1 

%SSiPrshMatrix: 5 612.0000 0.0000 1 

%SSiPrshMatrix: 4 13.5000 13.5000 1 

%SSiPrshMatrix: 5 612.0000 0.0000 1 

%SSiPrshMatrix: 4 58.5000 58.5000 1 

%SSiPrshMatrix: 5 612.0000 0.0000 1 

%SSiPrshMatrix: 4 13.5000 13.5000 1 

%SSiPrshMatrix: 5 612.0000 0.0000 1 

%SSiPrshMatrix: 4 0.0000 0.0000 1 

%SSiPrshMatrix: 3 54.0000 0.0000 1 

%SSiPrshMatrix: 4 0.0000 0.0000 0 

%SSiPrshMatrix: 5 792.0000 0.0000 0 

%SSiPrshMatrix: 4 54.0000 54.0000 0 

%SSiPrshMatrix: 5 792.0000 0.0000 0 

%SSiPrshMatrix: 4 0.0000 0.0000 0 

%SSiPrshPage: 58.5000 54.0000 612.0000 792.0000 7 16 15 0.0000 0.0000 0.0000 

0.0000 24580 0.0000 1.0000 0.0000 1 0.0000 0.0000 

%SSiPrshPage: 697.5000 54.0000 612.0000 792.0000 7 1 2 0.0000 0.0000 0.0000 

0.0000 24580 0.0000 1.0000 0.0000 1 0.0000 0.0000 

%SSiPrshPage: 1426.5000 54.0000 612.0000 792.0000 7 4 3 0.0000 0.0000 0.0000 

0.0000 24580 0.0000 1.0000 0.0000 1 0.0000 0.0000 

%SSiPrshPage: 2065.5000 54.0000 612.0000 792.0000 7 13 14 0.0000 0.0000 0.0000 

0.0000 24580 0.0000 1.0000 0.0000 1 0.0000 0.0000 

%SSiPrshPage: 58.5000 954.0000 612.0000 792.0000 5 9 10 0.0000 0.0000 0.0000 

0.0000 24580 0.0000 1.0000 0.0000 1 0.0000 0.0000 

%SSiPrshPage: 697.5000 954.0000 612.0000 792.0000 5 8 7 0.0000 0.0000 0.0000 

0.0000 24580 0.0000 1.0000 0.0000 1 0.0000 0.0000 

%SSiPrshPage: 1426.5000 954.0000 612.0000 792.0000 5 5 6 0.0000 0.0000 0.0000 

0.0000 24580 0.0000 1.0000 0.0000 1 0.0000 0.0000 

%SSiPrshPage: 2065.5000 954.0000 612.0000 792.0000 5 12 11 0.0000 0.0000 

0.0000 0.0000 24580 0.0000 1.0000 0.0000 1 0.0000 0.0000 

%SSiPrshMatrix: 7 -1.0000 0.0000 0 

%SSiSignature: |8 Page W/T| 8 6 1 

%SSiPressSheet: 2736.0000 1800.0000 0.0000 72.0000 1 324.0000 1 18.0000 

%SSiPrshMark: 2376.0000 -72.0000 360.0000 25.7040 18 0.0000 |Sig: $sig-W/T 

$color| 0.0000 0 100 100 100 100 9 1 1 0 0 0.0000 0.0000 
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%SSiPrshMark: 0.0000 -72.0000 432.0000 25.7040 18 0.0000 |$comment| 0.0000 0 

100 100 100 100 9 1 1 0 0 0.0000 0.0000 

%SSiPrshMark: 720.0000 882.0000 576.0000 27.0000 2 27.0000 |Sig: $sig Side: 

$side $color| 0.0000 0 60 60 100 100 1 1 1 0 0 0.0000 0.0000 

%SSiPrshMatrix: 1 4.0000 0.0000 1 

%SSiPrshMatrix: 8 612.0000 0.0000 1 

%SSiPrshMatrix: 9 792.0000 0.0000 1 

%SSiPrshMatrix: 11 36.0000 0.0000 1 

%SSiPrshMatrix: 10 0.0000 0.0000 1 

%SSiPrshMatrix: 12 7.0000 0.0000 1 

%SSiPrshMatrix: 2 58.5000 0.0000 1 

%SSiPrshMatrix: 4 0.0000 0.0000 1 

%SSiPrshMatrix: 5 612.0000 0.0000 1 

%SSiPrshMatrix: 4 13.5000 13.5000 1 

%SSiPrshMatrix: 5 612.0000 0.0000 1 

%SSiPrshMatrix: 4 0.0000 0.0000 1 

%SSiPrshMatrix: 3 54.0000 0.0000 1 

%SSiPrshMatrix: 4 0.0000 0.0000 0 

%SSiPrshMatrix: 5 792.0000 0.0000 0 

%SSiPrshMatrix: 4 54.0000 54.0000 0 

%SSiPrshMatrix: 5 792.0000 0.0000 0 

%SSiPrshMatrix: 4 0.0000 0.0000 0 

%SSiPrshPage: 58.5000 54.0000 612.0000 792.0000 7 8 7 0.0000 0.0000 0.0000 

0.0000 24580 0.0000 1.0000 0.0000 1 0.0000 0.0000 

%SSiPrshPage: 697.5000 54.0000 612.0000 792.0000 7 1 2 0.0000 0.0000 0.0000 

0.0000 24580 0.0000 1.0000 0.0000 1 0.0000 0.0000 

%SSiPrshPage: 58.5000 954.0000 612.0000 792.0000 5 5 6 0.0000 0.0000 0.0000 

0.0000 24580 0.0000 1.0000 0.0000 1 0.0000 0.0000 

%SSiPrshPage: 697.5000 954.0000 612.0000 792.0000 5 4 3 0.0000 0.0000 0.0000 

0.0000 24580 0.0000 1.0000 0.0000 1 0.0000 0.0000 

%SSiPrshMatrix: 7 -1.0000 0.0000 0 
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2. SMARTMARK (SMK) DEFINITION FORMAT 

SmartMarks were introduced into Preps with the 5.0 
release. The format is found both in .SMK files and in 
.TPL (template) files with very slight differences. The 
format is internal and proprietary and may change 
without notice to external partners. However, such 
changes will be accompanied by a change in version 
number (see the General Format section) on the first 
line. 

2.1 General Format 

The general format of a SmartMark is a series of lines, 
each of which contains a keyword prefix, a colon, a 
space, and then zero to two parameters, depending on 
the keyword.  

The box to the right shows a sample SmartMark for a 
perfect-bound collation mark. 

2.1.1 Keywords overview 

The first and last keywords are unique in that they start 
with the “%” character. Except for the first and last 
keywords, all keywords are written in lowercase but are 
recognized as case-insensitive.  

The first keyword, %SSiSmartMarkStart also takes as 
its first parameter the version of the definition being used. For the release version of Preps 
5.0, this version number is 2.  

The second parameter of this first line indicates the particular type of SmartMark being 
defined. For more details about the legal values, see Table 5 on page 20.  

2.1.2 Parameter formats overview 

Now a word about parameter formats. There are three types of parameters: integers, floating 
point, and strings. Integers are always represented in decimal form, floating point is always 
represented conventionally (that is without exponential notation). Strings are delimited by a 
single nonblank character which does not appear in the string. The default string delimiter is 
the vertical bar. The last-chance string delimiter is the unprintable character whose hex value 
is 1F. 

There is no provision for comments in a SmartMark definition, but embedded empty lines are 
skipped. 

%SSiSmartMarkStart:  2 4 

name: |Perfect-bound 
collation| 

text: || 

dupflags: 35 

sigstart: 1 

sigmod: 1 

colortype: 0 

color1: 100 

color2: 100 

color3: 100 

color4: 100 

rotation: 0 

smartoffsetx: 0.0000 

smartoffsety: 360.0000 

refentity: 2 

refanchor: 7 
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2.2 SmartMark Keyword Descriptions 

The following table describes the various keywords that appear in a SmartMark definition. 
Not all keywords will appear in all SmartMark definitions. The keywords in the table are 
presented in alphabetical order. Except for %SSiSmartMarkStart and %SSiSmartMarkEnd, 
the order in which the keywords appear (one per line) is not significant. 

Table 3  SmartMark Keywords 

SmartMark Keyword Description Parameters 

%SSiSmartMarkStart Always the first line of a SmartMark definition Version (of SmartMark 
definition) and Mark 
Type (see Table 5)) 

%SSiSmartMarkEnd Always the last line in a SmartMark definition. None. 

Collsize Only present for collation marks. Currently 
unused. Represents the length of the collation 
mark (along the direction of the step).as a 
percentage of the length of the adjacent page 
edges. In Preps 5.0, the size of all collation 
marks are statically determined. 

One floating-point 
parameter in the range 
0 to 100 

Collstart Used only for collation marks. Represents the 
offset of the collation mark from the reference 
edge. 

One floating-point 
parameter 

Color1 Same as corresponding %PrshMark parameter 
(see page 7)  

One unsigned integer 
parameter 

Color2  Same as corresponding %PrshMark parameter 
(see page 7) 

One unsigned integer 
parameter 

Color3  Same as corresponding %PrshMark parameter 
(see page 7) 

One unsigned integer 
parameter 

Color4  Same as corresponding %PrshMark parameter 
(see page 7) 

One unsigned integer 
parameter 

Colortype  Same as corresponding %PrshMark parameter 
(see page 7) 

One unsigned integer 
parameter 

Dupflags Same as corresponding %PrshMark 
parameter(see page 7) 

One unsigned integer 
parameter 

Flatid Only used for text marks. If TRUE then the text 
mark is a Flat-Identifier mark. Otherwise, it is a 
simple text mark. The difference is the backside 
placement. 

One boolean 
parameter 

Gapfrompage Only present for collation marks. Currently 
ignored. 

One floating-point 
parameter 

Height Height for fixed-height dupmark and rectangle 
marks 

One floating-point 
parameter 

Linestyle Only used for line marks 0 = SOLID 
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SmartMark Keyword Description Parameters 

1 = DOTTED 

2 = DASHED 

Markanchor Anchor for the mark Anchor index (see 
Table 4) 

Name Name of the SmartMark as shown in the UI. One string parameter 

Opttext Only used for collation marks. Represents the 
optional text that one can place for collation 
marks 

One string parameter 

Origingroup Name of the group from which this mark was 
imported. Only present for imbedded 
SmartMarks. 

One string parameter 

Outsideonly Only used for crop marks One boolean 
parameter 

Refanchor The reference anchor associated with refentity. 
Not used for collation marks. 

Anchor index (see 
Table 4)  

Refanchorb The reference anchor associated with 
refentityb. This may be different than refanchor 
value only for variable width or variable height 
marks (e.g. line, rectangle, or dupmark). 

Anchor index (see 
Table 4) 

Refentity The rectangle on the signature used as the 
basis for positioning the mark. Not used for 
collation marks. 

Entity index (see Table 
6) 

Refentityb The second rectangle on the signature used as 
the basis for positioning “two-point” marks, i.e. 
the line, rectangle, and dupmark marks. In 
Preps 5.0 refentityb, when defined, is always 
the same as refentity. 

Entity index (see Table 
6) 

Rotation Rotation in degrees of a text, custom, or 
dupmark. 

One unsigned integer 
parameter 

Section Either zero or the same as the “delivery” 
%PrshMark parameter(see page 7) Zero 
indicates that the mark is to be included in all 
sections of a multi-section signature. 

One unsigned integer 
parameter 

Sigmod Same as corresponding %PrshMark parameter 
(see page 7) 

One unsigned integer 
parameter 

Sigstart Same as corresponding %PrshMark parameter 
(see page 7) 

One unsigned integer 
parameter 

Smartoffsetb Offset in points (and PostScript space) from 
refanchorb of refentityb.  

This value is used only for “two-point” marks, 
meaning line marks, rectangle marks, and 

Two floating-point 
parameters (the X,Y 
pair) 
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SmartMark Keyword Description Parameters 

dupmarks. In the case of fixed-sized marks, it 
represents the far corner of a conceptual 
bounding rectangle from the point defined by 
(Smartoffsetx,Smartoffsety). 

Smartoffsetx  Horizontal Offset in points (and PostScript 
space) from refanchor of refentity 

One floating-point 
parameter 

Smartoffsety Vertical offset in points (and PostScript space) 
from refanchor of refentity. 

One floating-point 
parameter 

Stepsize Only used for collation marks. Same as the 
“size” %PrshMark parameter(see page 7)  

One floating-point 
parameter 

Text  Either the simple name of the eps file for a 
dupmark or custom mark or the text for a text 
mark1 Substitution of the PDF equivalent of the 
EPS mark file happens automatically for PDF-
>PDF jobs. 

One string containing 
possible substitutors 

Usealternateedge Used only for collation marks. Interpretation 
depends on the binding style of the collation 
mark, but it generally represents which of two 
edges of the high/low folio pages to measure 
the collstart value from. 

One boolean 
parameter 

Width Width for fixed-width dupmark and rectangle 
marks. For collation marks, this is the width of 
the collation mark (meaning the dimension 
orthogonal to the stepping direction). 

One floating-point 
parameter 

 

                                                 
1  For collation marks, the text represents the three non-eps-based collation marks by using the texts:  
'SIGNATURE COLLATION MARK A', 'SIGNATURE COLLATION MARK B' and 

  'SIGNATURE COLLATION MARK C'.  The default value for collation marks when the TEXT parameter is 
empty is 'SIGNATURE COLLATION MARK A'. 
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2.3 SmartMark Ordinal Definitions 

The tables in this section describe the meanings of ordinal numbers found in SmartMark 
definitions. 

The following table describes the assigned numeric value that identifies each of the nine 
points for anchoring a SmartMark.  

Table 4  SmartMark Anchor Points 

Value Meaning 

1 Top left corner  

2 Center point of top edge 

3 Top right corner 

4 Center point of right edge 

5 Bottom right corner 

6 Center point of bottom edge 

7 Bottom left corner 

8 Center point of left edge 

9 Center point of rectangle 

0 Unspecified. Used when anchors are not 
meaningful (e.g. in collation marks) 

 
The following table specifies the assigned numeric values that identify each type of 
SmartMark. These values appear as the second parameter to the %SSiSmartMarkStart 
keyword. 

Table 5  SmartMark Type Values 

Value Meaning 

1 Text Mark 

2 Custom Mark 

3 SideGuide (unused in Preps 5.0) 

4 Perfect Collation Mark 

5 Saddle-stitch Collation Mark 

6 Fold Mark 

7 Line 

8 Rectangle 

9 Dupmark 

10 Crop Mark 
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The following table describes the assigned definition and numeric values that identify each of 
the rectangles used for placing SmartMarks on a surface of a signature. 

Table 6  SmartMark Rectangle Identities 

Value Rectangle Identity Definition 

0 None Placeholder for use in line, rectangle, and dupmark and collation 
SmartMarks.  

1 Media Page size and position as given by the current device. The media 
rectangle is the only rectangle that is sensitive to the settings of the 
current device. If it is determined that the media rectangle is too 
small to fit the entire signature (meaning it will not fit on a single tile), 
then media-based SmartMarks will not image. 

2 Press sheet Sheet size as given by the signature definition 

3 Imposition Farthest extents of the trim boxes of all pages in an imposition 

4 Imposition-with-
bleeds 

Farthest extents of the bleed boxes of all pages in an imposition2 

5 Top Margin Rectangle from the imposition top to the press-sheet top, and from 
the imposition left edge to the imposition right edge. 

6 Bottom Margin Rectangle from the imposition bottom to the press-sheet bottom, and 
from the imposition left edge to the imposition right edge. 

7 Left Margin Rectangle from the imposition left to the press-sheet left, and from 
the imposition top edge to the imposition bottom edge. 

8 Right Margin Rectangle from the imposition right to the press-sheet right, and from 
the imposition top edge to the imposition bottom edge. 

9 Top Right Margin Rectangle from the imposition right to the press-sheet right, and from 
the imposition top edge to the press-sheet top edge. 

10 Top Left Margin Rectangle from the imposition left to the press-sheet left, and from 
the imposition top edge to the press-sheet top edge. 

11 Bottom Right Margin Rectangle from the imposition right to the press-sheet right, and from 
the imposition bottom edge to the press-sheet bottom edge. 

12 Bottom Left Margin Rectangle from the imposition left to the press-sheet left, and from 
the imposition top edge to the press-sheet top edge. 

13 Vertical Gutters Set of vertical gaps between trim boxes of the pages of an 
imposition. Each gutter is a rectangle that crosses directly from one 
side of the imposition to the other and extends to the edge of the 
imposition-with-bleeds rectangle. 

14 Horizonal Gutters Set of horizontal gaps between trim boxes of the pages of an 
imposition. Each gutter is a rectangle that crosses directly from one 
side of the imposition to the other and extends to the edge of the 
imposition-with-bleeds rectangle. 

 

                                                 
2 Note that bleed margins are set on a per-job basis. This means that the shapes of bleed-related reference 
entities (Imposition-with-bleeds, VerticalGutters, and HorizontalGutters) might be different in the template 
editor than in a preview or print operation.  In the template editor, the bleeds are determined by either 
METRIC_BLEED_MARGIN or AMERICAN_BLEED_MARGIN settings in the current profile. 
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